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Legal Notice  

Copyright © 2006-2008 Nokia. All rights reserved.  

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form without the prior written 
permission of Nokia is prohibited.  

Nokia and Nokia Connecting People are trademarks or registered trademarks of Nokia Corporation. Other product and company names 
mentioned herein may be trademarks or tradenames of their respective owners.  

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and improvements to any of the products 
described in this document without prior notice.  

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental, consequential or indirect 
damages howsoever caused.  

The contents of this document are provided “as is”. Except as required by applicable law, no warranties of any kind, either express or 
implied, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose, are made in relation 
to the accuracy, reliability or contents of this document. Nokia reserves the right to revise this document or withdraw it at any time 
without prior notice.  

The availability of particular products may vary by region. Please check with the Nokia dealer nearest to you.  
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1. About this document  
The purpose of this guide is to describe the functionality of Nokia Configuration Tool application and provide instructions for 
installing the application. For step–by-step instructions and more detailed information, refer to Nokia Configuration Tool help.  

1.11.11.11.1 Target audience  
This document is intended for anyone who is responsible for maintaining settings information for Nokia devices and transferring 
updated settings to the Nokia devices.  

1.21.21.21.2 Scope  
This document introduces Nokia Configuration Tool.  

• Chapter 1, About this document  

• Chapter 2, Introduction to Nokia Configuration Tool as well as information about new features in this release.  

• Chapter 3, Installation Safety notes, system and security requirements, and instructions on how to install Nokia configuration Tool.  

• Chapter 4, Startup and shutdown of Nokia Configuration Tool  

• Chapter 5, Working with Nokia Configuration Tool  

• Chapter 6, Profile settings  

• Chapter 7, Troubleshooting instructions for problem situations.  

• Chapter 8, Restrictions and Known issues  

After reading this guide, the reader will be familiar with the basic functions and range of uses of Nokia Configuration Tool.  

1.31.31.31.3 Related documents  
For step-by-step instructions and more detailed information, refer to Nokia Configuration Tool help.  

For other related information, refer to the following documents:  

• Nokia PC Suite user guide  

• Your Nokia device user guide  

• Your personal computer (PC) user guide  
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2. Introduction to Nokia Configuration Tool  
Nokia Configuration Tool is a PC application that enables you to manage the settings of selected Nokia devices. Your PC and the 
devices must be connected through Nokia PC Suite and a Universal Serial Bus (USB) cable. Nokia Configuration Tool uses SyncML Data 
Synchronization (DS) and Device Management (DM) protocols, which are defined by Open Mobile Alliance (OMA).  

With Nokia Configuration Tool, you can configure various settings, such as wireless LAN (if available), email, and Internet access 
points (IAP) on several devices at the same time. You can also transfer files, contact cards, and applications, if available.  

The configuration is performed by sending a configuration profile to a phone. The configuration profile is a group of settings; you can 
create different profiles for different purposes and different types of devices. The settings that are defined in a profile are configured 
to a device when you transfer the profile to that device.  

You can use a compatible connection cable (USB) to transfer configuration profiles to devices. For connectivity and system 
information, refer to Section 3.2, System requirements.  

To view the version, copyright date, and other important legal information about Nokia Configuration Tool, select Help > About Nokia Help > About Nokia Help > About Nokia Help > About Nokia 
Configuration ToolConfiguration ToolConfiguration ToolConfiguration Tool from the main menu.  

2.12.12.12.1 Supported devices  
This release of Nokia Configuration Tool supports following Nokia devices: Nokia E51, Nokia E51-2, Nokia E60, Nokia E61, Nokia E61i, 
Nokia E62, Nokia E65, Nokia E66, Nokia E70, Nokia E71, Nokia E90 Communicator, Nokia 9300i, Nokia 9300 and Nokia 9500 
Communicator.  

2.22.22.22.2 Changes in this release  
This release of Nokia Configuration Tool includes the following changes compared to release 2.3:  

• Support for new devices Nokia E66 and Nokia E71  

• Support for Device Encryption settings  

• Support for Device Manager settings  

• Support for General VoIP settings  

• Support for Intranet Browsing settings  

• Support for importing certificates from PC to device  
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3. Installation  
This chapter describes the system requirements, installation process, and some safety and security issues.  

3.13.13.13.1 Important safety notes  
All the safety instructions in the user's guides of your device and PC also apply when the Nokia Configuration Tool is used with the 
device.  

Remember to make backup copies of all important data to protect against possible loss or alteration.  

Only install and use applications and other software from sources that offer adequate protection against harmful software.  

3.23.23.23.2 System requirements  
To install and use Nokia Configuration Tool, you need the following:  

• A compatible Nokia device  

• A PC with Windows Vista™, Windows XP™ or Windows 2000™ operating system (SP4 or newer)  

• Minimum display resolution of 1024 x 768 pixels  

• At least 25 MB of free disk space  

• Nokia PC Suite 6.86 or a later version  

• Internet Explorer 5.0 or later (for Nokia Configuration Tool help)  

• For connectivity, a USB connection port on your PC and a suitable Nokia Connectivity Cable  

For information on connecting the device to your PC, refer to the Nokia PC Suite user guide, the Nokia device user guide, or the PC 
user guide.  

3.33.33.33.3 Security requirements  
Nokia Configuration Tool does not encrypt any information or settings that are saved and stored to your PC. For example, if you 
create a profile that contains passwords and user names, this information is not encrypted when you save the profile to your PC.  

If you want to encrypt the information and settings that are saved and stored to your PC, you must use a standard encryption 
program on your PC. For more information about encryption, refer to the PC user guide.  

3.43.43.43.4 Installing  
• Note:Note:Note:Note: You must have the Nokia PC Suite installed on your PC before you can install Nokia Configuration Tool.  

• Note:Note:Note:Note: If you encounter any problems while uninstalling an old version of Nokia Configuration Tool, it is recommended to uninstall 
the old version of the tool from Control Panel -> Add/Remove programs.  

To install Nokia Configuration Tool:  

1. Double-click on Nokia Configuration Tool icon. The Installation Wizard opens.  

2. In the Installation Wizard window use the arrow buttons to move forward and back if you want to change some settings.  

3. If you accept the terms of the license agreement, check the appropriate box and click NNNNextextextext. You cannot install Nokia Configuration 
Tool without accepting the terms.  

4. In the Installation folder window, click NextNextNextNext or, if necessary, specify the location where you want to install the software, and click 
NextNextNextNext.  

5. Click NextNextNextNext to start the installation.  

6. In the Installation completed window, exit the Wizard by clicking NextNextNextNext.  
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4. Startup and Shutdown of Nokia Configuration Tool  
Start Nokia Configuration Tool from the Start menu or the Desktop of the PC by clicking Nokia Configuration Tool icon.  

Nokia Configuration Tool is fully functional only after you have connected a compatible Nokia device to the PC and have selected USB 
(Universal Serial Bus) as the connection method in the PC Suite Connection Manager application.  

Nokia Configuration Tool displays a window that gives information about the Device Management solution. To prevent the window 
from being displayed each time you start Nokia Configuration Tool, select the check box Do not show this dialog againDo not show this dialog againDo not show this dialog againDo not show this dialog again. If you change 
your mind later and want the window to be displayed again, select Tools > Show DM info at startupTools > Show DM info at startupTools > Show DM info at startupTools > Show DM info at startup.  

When you start Nokia Configuration Tool for the first time, the tool prompts you to either select an existing workspace or create a 
new one. A workspace contains the device data files and configuration profiles for the devices. You can, for example, create different 
workspaces for different sets of devices.  

After you have selected whether to open an existing workspace or to create a new one, the workspace view is displayed.  

To exit the application, select File > ExitFile > ExitFile > ExitFile > Exit. 
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5. Working with Nokia Configuration Tool  
This chapter describes the navigation rules, workspaces, devices, profiles and search tools in Nokia Configuration Tool.  

5.15.15.15.1 Navigation Rules  
Use keyboard shortcuts to quickly open menus in the workspace. Shortcuts allow you to open windows in the application using only 
the keyboard. Any menu or button that contains an underlined letter (for example, New...New...New...New...) can be quickly accessed by pressing the AltAltAltAlt 
key + the underlined letter (for example, Alt+NAlt+NAlt+NAlt+N). Note that the underlining may appear only after the AltAltAltAlt key is pressed.  

5.25.25.25.2 Workspaces  
A workspace is a directory that contains device data files (the DevicesDevicesDevicesDevices list) and configuration profiles (the Profiles Profiles Profiles Profiles list).  

The title of the current workspace is shown in the Window caption.  

By using the FileFileFileFile menu, you can:  

• Open existing workspaces.  

• Create new workspaces.  

• Create a duplicate of the currently open workspace and all of its contents.  

• Delete an existing workspace.  

5.35.35.35.3 Managing Devices  
The DevicesDevicesDevicesDevices list displays all connected devices and all devices that have been modified.  

To manage DevicesDevicesDevicesDevices, you can:  

• Press the “Edit online…” button to edit the settings of a single device online on your PC. For more information on the settings, 
refer to Chapter 6, Profile settings.  

• Select a device, press right mouse button and select “Configure…” from the menu to send previously saved configuration profiles 
to a device.  

• Select a device, press right mouse button and select "Edit device info…" to edit device information. You can enter a name to 
identify a device, the personal ID of the user of the device, email address and other info about the device.  

• Select a device, press right mouse button and select “Delete device” to delete devices from Nokia Configuration Tool.  

If you are connected to a device that you have removed from the list, the device is shown in the list of devices as a new device. 

NoteNoteNoteNote: Before you can edit a device online or send settings (profiles) to a device, your PC and the device must first be connected using 
Nokia PC Suite.  

NoteNoteNoteNote: When settings are imported from and sent to a device, a conversion is made between UTF-8 (Unicode Transformation Format-
8) and the operating system’s default character map. You can send and import all characters that can be converted between UTF-8 
and the operating system’s default character map. Almost every language supports currency characters (such as, €, $ and £) and at 
least some mathematical operation characters. You can also send and import Scandinavian characters with Nokia Configuration Tool, 
if the operating system’s default character map supports Scandinavian characters.  
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The devices list contains five columns by default:  

Column Description 
Device name Displays the name of the device. A new device displays the device IMEI code. 

Device type Displays the type of device. For example, Nokia 9300 (EA). 
Connection Displays an icon representing a connection between the PC and a device. A 

device that is shown but not connected displays None as the connection type. 

Last known profile Displays the name of the last known configuration profile in the device. A new 
device displays NoneNoneNoneNone as the last known profile. 

Sent Displays the date that the last known profile was sent to the device. A new 
device displays NoneNoneNoneNone as the date. 

 
You can select which columns are shown by clicking right mouse button over the list heading and selecting or deselecting the 
wanted columns.  

To sort the list according to the contents of a column, click on the column heading. The arrow in the column heading indicates the 
sorting order. Click the column heading again to sort the list in the opposite order.  

5.45.45.45.4 Profiles  
A profile is a group of settings, such as wireless LAN, email, or Internet access point settings. Profiles are stored as an XML file in the 
workspace. You can create several different profiles for different purposes and for different devices. The settings that are defined in a 
profile are configured to a device when you send the profile to it. The available settings depend on the type of the device.  

To manage the ProfilesProfilesProfilesProfiles, you can:  

• Import profiles  

• Create new profiles  

• Edit and duplicate profiles  

• Send profiles to devices  

• Delete profiles.  

NoteNoteNoteNote: Before you can send or import profiles and settings to a device, your PC and the device must first be connected using the Nokia 
PC Suite.  

NoteNoteNoteNote: When profiles are imported from and sent to a device, a conversion is made between UTF-8 (Unicode Transformation Format-
8) and the operating system’s default character map. You can send and import all characters that can be converted between UTF-8 
and the operating system’s default character map. Almost every language supports currency characters (such as, €, $ and £) and at 
least some mathematical operation characters. You can also send and import Scandinavian characters with Nokia Configuration Tool, 
if the operating system’s default character map supports Scandinavian characters.  

NoteNoteNoteNote: It is not recommended to send or import a profile with Nokia Configuration Tool while using other Nokia PC Suite applications  
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The profiles list contains three columns by default:  

Column Description 
Profile name Displays the name assigned to the profile. 
Device type Displays the type of device. For example, Nokia 9300. 
Updated Displays the date the profile was last edited. 

 

You can select which columns are shown by clicking right mouse button over the list heading and selecting or deselecting the 
wanted columns.  

To sort the list according to the contents of a column, click on the column heading. The arrow in the column heading indicates the 
sorting order. Click the column heading again to sort the list in the opposite order.  

5.55.55.55.5 Search Tools  
Nokia Configuration Tool features three search functions. To find a specific device or profile in the list:  

• Use the Advanced SearchAdvanced SearchAdvanced SearchAdvanced Search from the ToolsToolsToolsTools menu to search for items in your devices and profiles. In addition, the advanced search 
can be used to find profile and contact filenames.  

• Use the Device typeDevice typeDevice typeDevice type drop-down list to filter the devices and profiles according to the device type.  

• Use the Show only items containingShow only items containingShow only items containingShow only items containing function filter the devices according to device attribute.  
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6. Profile settings  
Nokia Configuration Tool allows you to create and edit settings, for example, for email and Internet access points. You can store 
different sets of settings as profiles. For more detailed information on the settings available for specific devices, refer to Nokia 
Configuration Tool help.  

• Note:Note:Note:Note: The available settings vary according to the type of device.  

• Note:Note:Note:Note: If you import the profile settings from the phone, edit the configuration profile in Nokia Configuration Tool and then send 
the profile back to the phone, the profile settings are duplicated in the phone. Sending a profile to the phone never replaces the 
existing settings. To edit settings that are already in the phone, you must use Nokia Configuration Tool Edit Online functionality.  

• Note:Note:Note:Note: Please avoid the € character for all settings.  

• Note:Note:Note:Note: After you have imported a profile from a device, the profile will include a default WLAN access point (Easy WLAN), and 
default PC suite profiles that relate to the internal implementation of the devices. These settings can not be modified in Nokia 
Configuration Tool and are therefore disabled.  

After importing a profile from a device, it is recommended to delete the Easy WLAN access point from the configuration profile. In the 
“Edit configuration profile” view, select “Access points” on the left. Then highlight the Easy WLAN access point and press the Delete 
button on the right. Deleting the Easy WLAN access point from the profile will not delete the corresponding access point in the 
device.  

Similarly, it is recommended to delete the default PC Suite profiles from the Device Management and Sync sections.  

The following settings are available:  

• Internet access points (IAP):Internet access points (IAP):Internet access points (IAP):Internet access points (IAP): Create new or duplicate access points, and edit or delete existing access point connections for the 
selected profile. GPRS / Packet data (proxies and IP configuration) settings are available for all supported devices. IP Passthrough 
and WLAN (proxies, WEP keys, and IP configuration) settings are available for some devices.  

• Note:Note:Note:Note: WLAN and IP Passthrough settings are not available for all devices.  

• Email account settings:Email account settings:Email account settings:Email account settings: Create new or duplicate email accounts, and edit or delete existing email accounts for the selected profile. 
You can edit the name of the email account, your name in the account, the email address, and the IAP and the SMTP server for the 
account. You can also define the IMAP4 or POP3 server as well as user names and passwords for these. Similarly, you can select 
whether to use SMTP authentication, and set the user names and passwords.  

• NotNotNotNote:e:e:e: You must first create an IAP group before you can define the IAP in the email account, SIP, IM server, and MMS settings. If 
the IAP you want is already defined in the phone and you do not want to modify the settings through the phone’s user interface, 
you can send the profile to the phone without the IAP setting, and then add the IAP to the needed IAP group while editing the 
profile online.  

• SIP settings:SIP settings:SIP settings:SIP settings: You can create, duplicate, edit and remove session initiation protocol (SIP) settings. You can edit the name of the 
profile, the service profile (IETF or Nokia 3GPP), access point, public user name, compression, registration, and security settings. 
You can also define the proxy and registrar server settings. Address, realm, user name, transport type (UDP or TCP) and port 
settings are available. You can also select whether to use loose routing with the proxy server.  

• IM server settings:IM server settings:IM server settings:IM server settings: You can create, duplicate, edit and remove IM server settings for the selected profile. You can edit the name of 
the IM server settings and also the access point, the web address, and your username and password to be used for the IM server.  

• Internet tel. settings:Internet tel. settings:Internet tel. settings:Internet tel. settings: You can define which SIP settings profile you wish to use for Internet calls.  

• Note:Note:Note:Note: You must first create a SIP settings profile before you can define the SIP profile for Internet calls.  

• MMS settings:MMS settings:MMS settings:MMS settings: You can edit the multimedia message service (MMS) settings. You can select whether or not you want to send MMS 
settings to the device. You can also select whether or not to allow anonymous messages, receive advertisements, and allow report 
sending and receiving. Image size, MMS creation mode, access point, multimedia retrieval and message validity settings are also 
available.  

• Note:Note:Note:Note: MMS settings are only available for Nokia E60 device.  

• SyncML (DS)SyncML (DS)SyncML (DS)SyncML (DS)    /data synchronization settings/data synchronization settings/data synchronization settings/data synchronization settings: You can create new or duplicate, edit, or delete existing data synchronization (DS) 
profiles for the selected profile. You can define the profile name and the connection type (Bluetooth and data cable to synchronize 
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with a PC; synchronizing with a server on the Internet is also possible). Note that some models do not support a data cable. You 
can edit the user ID and the password for the synchronization server. If you select Internet as the connection type, you can define 
the access point and the port number of the synchronization server.  

• SyncML (DM) / device manager settingsSyncML (DM) / device manager settingsSyncML (DM) / device manager settingsSyncML (DM) / device manager settings: You can create new or duplicate, edit, or delete existing device management profiles for 
the selected profile. You can select the connection type (Bluetooth and data cable to synchronize with a PC; synchronizing with a 
server on the Internet is also possible). Note that some models do not support a data cable. You can edit the name, ID and 
password for the synchronization server. Editing the host address is also possible. If you select Internet as the connection type, 
you can define the access point and the port number of the synchronization server.  

• FilesFilesFilesFiles: Add files that you wish to transfer to a selected device. You can rearrange the files, specify a target folder and delete as 
needed. Note that this only edits the files and folder in the profile, not on the selected device.  

• ApplicationsApplicationsApplicationsApplications: You can add or delete applications, or change the installation order of the applications that you wish to transfer to a 
selected device. The added files must be compatible with the target device. Software installation files must have the extension . 
jad, .jar, .sis or .sisx. Note that some models do not support this feature.  

• ContactsContactsContactsContacts: You can import and delete contact cards and create contact cards to be transferred to a selected device. You can import 
a CSV file that contains contact information (e.g., export CSV files from Microsoft Outlook or other email applications). The contact 
dialog in Nokia Configuration Tool accepts only VCF and CSV files.  

• SCCPSCCPSCCPSCCP: You can create new or duplicate, edit or delete existing SCCP profiles for the selected profile. An SCCP profile specifies the 
connection to Cisco Unified Communications Manager.  

• VPN aVPN aVPN aVPN and PKI certificatesnd PKI certificatesnd PKI certificatesnd PKI certificates: You can define VPN (Virtual Private Network) settings to allow you to access enterprise intranet services 
securely from mobile devices. You can also view certificates and change their trust settings, or import a certificate from your PC 
and send it to the device.  

• Mail for ExchangeMail for ExchangeMail for ExchangeMail for Exchange: You can specify settings for email, calendar and contacts synchronization.  

• Nokia ICC for AlcatelNokia ICC for AlcatelNokia ICC for AlcatelNokia ICC for Alcatel----LucentLucentLucentLucent: You can specify settings for Intellisync Call Connect for Alcatel.  

• FFFF----SecureSecureSecureSecure: You can modify F-Secure Mobile Security settings.  

• Device Device Device Device EEEEncryptionncryptionncryptionncryption: You can manage the device data security with Device Encryption settings.  

• Device ManagerDevice ManagerDevice ManagerDevice Manager: You can add multiple device management profiles, or edit, duplicate and remove existing device management 
profiles.  

• General VoIP settingsGeneral VoIP settingsGeneral VoIP settingsGeneral VoIP settings: In General VoIP settings you can define some common VoIP settings.  

• Intranet BrowsingIntranet BrowsingIntranet BrowsingIntranet Browsing: You can define settings used with Intranet Browsing. With Intranet Browsing application you can browse your 
company’s intranet through a secure VPN (Virtual Private Network) connection. To be able to do that, you need to create company 
specific VPN policy.  
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7. Troubleshooting  
Common use  
QuestionQuestionQuestionQuestion: I connected my phone through Bluetooth and Nokia Configuration Tool found it. Can I use a Bluetooth connection with 
Nokia Configuration Tool?  

Answer: Even though Nokia Configuration Tool found the phone, it does not officially support the Bluetooth connection type. You 
can use the Bluetooth connection only at your own risk.  

QuestionQuestionQuestionQuestion: I connected my phone through Infrared and Nokia Configuration Tool found it. Can I use an Infrared connection with Nokia 
Configuration Tool?  

Answer: Even though Nokia Configuration Tool found the phone, it does not officially support the Infrared connection type. You can 
use the Infrared connection only at your own risk.  

QuestionQuestionQuestionQuestion: Nokia PC Suite does not detect my phone. What is the problem?  

Answer: Make sure Nokia PC Suite supports your phone. If it does not, check if a newer Nokia PC Suite version is available on the 
web. If Nokia PC Suite does not detect your phone, you cannot use Nokia Configuration Tool to configure your phone.  

QuestionQuestionQuestionQuestion: Nokia PC Suite detects my phone but Nokia Configuration Tool does not. What is the problem?  

Answer: Make sure Nokia Configuration Tool supports your phone. If it does not, you cannot configure your phone with Nokia 
Configuration Tool. The supported phones are listed in chapter 2.1 Supported devices. Check the contents of the Device type 
combobox. A connection problem between the phone and the PC may also cause the detection to fail. Reboot your computer, if 
possible, and restart Nokia Configuration Tool.  

QuestionQuestionQuestionQuestion: Neither Nokia PC Suite nor Nokia Configuration Tool detects my phone. What is the problem?  

Answer: Make sure that Nokia PC Suite and Nokia Configuration Tool support your phone. If they do, reboot your computer.  

QuestionQuestionQuestionQuestion: I imported all the data from my phone to Nokia Configuration Tool and then made some modifications. After that, I sent 
the profile back to my phone. Now I have duplicate settings on my phone. Why does my phone have duplicate settings, although I 
sent the original phone settings back to the phone?  

Answer: If you want to modify the settings that already exist on your phone, you have to use the “Edit Online” mode. If you import 
the settings and then send the same profile back to the phone, the existing settings are not replaced by the modified settings. 
Instead, duplicate settings are stored.  

QuestionQuestionQuestionQuestion: The calendar and contact contents of a SyncML (DS) group are not transferred to my phone. What is the problem?  

Answer: When editing the profile settings online, changing the settings of the Easy WLAN group, default SyncML (DS) groups and 
default SyncML (DM) group is not possible because these are default settings and changing these settings may cause problems. After 
importing a profile from a device, it is recommended to delete the Easy WLAN access point, the default SyncML (DS) groups and the 
default SyncML (DM) group from the configuration profile.  

QuestionQuestionQuestionQuestion: The WLAN WEP key ID, encryption and data values are not imported from my phone. What is the problem?  

Answer: For security reasons, those values are not imported from Nokia 9500 Communicator and Nokia 9300i devices.  

QuestionQuestionQuestionQuestion: Why does the Contact transfer fail? 
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Answer: If you transfer only one contact into a device and then delete it from the device, the subsequent contact transfers fail.  

QuestionQuestionQuestionQuestion: Why does an import fail?  

Answer: With some computer configurations, importing may fail. In an error situation, restart the computer and Nokia 
Configuration Tool. If that does not help, install Nokia Configuration Tool on a different computer.  

PKI  
Question: Question: Question: Question: I cannot see any PKI groups although my phone shows them. I also tried to send a new certificate file to the phone but it is 
not possible due to many errors during sending. What is wrong?  

Answer: Your phone doesn't have mVPN client software as a default. You have to install mVPN client software to your phone before 
it is possible to send or import PKI groups and settings.  

QuestionQuestionQuestionQuestion: I am not able to add a new certificate file to a profile. What is the problem?  

Answer: NCT allows certificate files to be added only in Edit online. Thus, if you navigate to the PKI group in Edit online, there is also 
Import button from which a new certificate file can be added to a profile.  

QuestionQuestionQuestionQuestion: I have added a new certificate file and there are three editable settings. One of them is Applicability setting and this list has 
such applications that are not intended to be used with my certificate file. How is it possible?  

Answer: NCT shows all applications of the phone that are available for certificates. So, you would need to know yourself convenient 
applications to which you want to authorize your certificate file.  

QuestionQuestionQuestionQuestion: I have made an import from my phone and now I tried to send the same setting to another phone. However there was 
many errors concerning to certificates.  

Answer: NCT does not support sending of certificates between two phones. That means that your imported certificates do not have 
all data that would be needed in the other phone. It is better to remove certificates from the imported profile so that you can avoid 
this kind of errors.  

QuestionQuestionQuestionQuestion: Why, after importing a new certificate to a profile in Edit online, I can not see any services/applications in the Applicability 
list?  

Answer: Applicability list only shows the services/applications if you have not pressed the update button previously in the same 
session. However, you can send the certificate to the phone and change the services/application settings in the phone. The second 
alternative is that you repeat the online edit and change these values then.  

VPN  
QuestionQuestionQuestionQuestion: I tried to create a new VPN access point, but I was not able to see it at all. The access point group has only 'Packet data' and 
'Wireless LAN' types. Where is VPN access point?  

Answer: VPN access points are added under the VPN group. The VPN group contains a group, 'Access points', where it is possible to 
create new VPN access points to be sent to the phone.  

QuestionQuestionQuestionQuestion: I cannot send VPN access point group to my phone, NCT only returns errors. What is wrong?  

Answer: Your phone doesn't have VPN client software as a default, it has to be installed. After installation of VPN, all errors will 
disappear. 
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QuestionQuestionQuestionQuestion: I created a VPN access point in Edit online, but I am not able to use it as an access point in any of the other setting groups. 
Where can I find it?  

Answer: You need to close the Edit Configuration Dialog and re-import settings from the phone by using Edit Online. After 
reopening edit online the VPN access point is also shown among the general access points, this enables the VPN access point to be 
used in other setting groups.  

Internet telephone settings  
QuestionQuestionQuestionQuestion: I configured SIP and Internet telephone settings in my phone and then I pressed the Import button that retrieved phone's 
settings to NCT. But now, I have an invalid profile that has a few empty and invalid settings. How can I correct that?  

Answer: Some phone models might cause problems in this case. You can change the profile settings manually so that the profile is 
valid. Also updating your device’s software may help.  

WLAN  
QuestionQuestionQuestionQuestion: I tried to update Allow PEAPv0 value but it does not seem to take effect. What is wrong?  

Answer: Some phone models do not allow changing PEAPv0, PEAPv1 and PEAPv3 values by using NCT. You need to change these 
settings in your phone.  

QuestionQuestionQuestionQuestion: I configured a WLAN access point with EAP-PEAP in the phone and imported it into NCT. Why is the CA certificate setting 
blank?  

Answer: Some certificates are not imported from some phone models and NCT can therefore not show the certificate reference if 
the certificate is not imported.  
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8. Restrictions and Known issues  
All settings:  
• Avoid the € character for all settings  

Email:  
• Make sure that a device includes no more than five (5) mailboxes before a send operation. Otherwise, problems may occur during 

the sending or importing operation.  

WLAN:  
• A WLAN access point called "Easy WLAN" is shown in Nokia Configuration Tool. It is not possible to modify this settings group.  

• If you create a WLAN access point with Nokia Configuration Tool and select "Open network" as the WLAN security mode, Nokia 
Configuration Tool may show an error message while sending the settings to a device. However, all settings of the WLAN access 
point have been sent to a device.  

• An imported WLAN access point that uses 802.1x as the WLAN security mode may appear empty in Nokia Configuration Tool  

• Importing a WPA pre-shared key from a device may fail.  

SIP Settings:  
• Sending to a device may fail in some combinations and it is not recommended to send more than one SIP profile at a time.  

Device Manager:  
• After you have imported a profile from a device, the profile will include default PC suite profiles that relate to the internal 

implementation of the devices. These settings can not be modified in Nokia Configuration Tool. After importing a profile from a 
device, it is recommended to delete the default PC Suite profiles from the Device Management section of the “Edit configuration 
profile” view.  

• If you configure more than one device manager settings at a time, the port numbers may cause problems.  

Sync:  
• After you have imported a profile from a device, the profile will include default PC suite profiles that relate to the internal 

implementation of the devices. These settings can not be modified in Nokia Configuration Tool. After importing a profile from a 
device, it is recommended to delete the default PC suite profiles from the Sync section of the “Edit configuration profile” view.  

• The host address may show incorrect information after Nokia Configuration Tool sending operation. The address concatenated 
with ":80" may be shown as the host address in the device "Host address" field.  
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Glossary 
802.11, 802.1x  
A group of specifications for wireless LAN technology.  

ad hoc  
In the ad hoc mode, devices can send and receive data directly with each other. No wireless LAN access point is needed.  

CSV  
Comma Separated Value. File format used to exchange data between disparate applications. Each line is one entry or record. The 
fields in a record are separated by commas.  

DNS  
Domain Name Server. An Internet service that translates domain names such as www.nokia.com into IPv4 addresses like 
192.100.124.195.  

IAP  
Internet Access Point. An IAP is needed to connect to the Internet.  

IM  
InstantMessaging. Enables you to create private chats with another person who is online.  

IMAP4  
IMAP4 is a version of Internet Message Access Protocol, a standard protocol for accessing email on your remote server. With IMAP4, 
you can search, create, delete, and manage messages and folders on the server.  

IMEI code  
International Mobile Equipment Identity. A number that uniquely identifies an individual mobile device. The IMEI usually appears on 
the label located in the battery compartment of the phone.  

infrastructure  
In the infrastructure mode, devices can communicate with each other and with wired LAN devices through a wireless LAN access 
point.  

GPRS  
General Packet Radio Service. GPRS is a technology that enables sending and receiving data over a mobile network. GPRS as such is a 
data bearer that enables wireless access to data networks like the Internet. Examples of applications that can use GPRS are Internet 
and email.  

OMA  
Open Mobile Alliance  

PC  
Personal Computer  

PKI  
Public Key Infrastructure  

POP3  
POP3 is a version of Post Office Protocol, a standard protocol for receiving email from your remote server. With POP3, you can check 
your remote mailbox and download your email.  

SCCP  
Skinny Client Control Protocol. SCCP is used by Nokia Intellisync Call Connect when connecting the Cisco Unified Communications 
Manager.  

SMTP  
Simple Mail Transfer Protocol. A protocol that is used to transfer email messages. Typically, SMTP is used only for sending. 
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SyncML  

Synchronization Markup Language. An open standard that enables synchronization of data between compatible devices, applications, 
and networks, which means that a consistent set of data is always available on any device or application. Sync ML is based on 
Extensible Markup Language (XML).  

TCP  
Transmission Control Protocol. One of the protocols in the Internet protocol suite. The protocol guarantees reliable and in-order 
delivery of sender to receiver data.  

TLS  
Transport Layer Security. A protocol that guarantees privacy and data integrity between applications communicating over the 
Internet.  

UTF-8  
Unicode Transformation Format-8  

vCard  
Format of a contact card file that can be sent to other devices. vCard file has the file extension .vcf.  

VoIP  
Voice over Internet Protocol.  

VPN  
Virtual Private Network.  

WEP  
Wired Equivalent Privacy. A security feature using the RC4 algorithm that performs wireless data encryption. WEP keys consist of a 
secret key and a 24-bit initialization vector. For example, some manufacturers refer to a 104-bit key as a 128-bit key (104+24). Both 
keys offer the same level of encryption and are therefore interoperable.  

WLAN  
Wireless Local Area Network. A local area network in which radio links instead of physical cables are used to connect devices.  

WPA  
Wi-Fi Protected Access. A security standard for wireless networks.   


